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With In-Room Control you can add
custom elements to your Touch10
and DX Series user interface. Such
user interface extensions may be
controls for lights or blinds, or
other peripherals (including one or
more video switches to extend the
number of video sources available),
all controlled by external control
systems.

Since both the Cisco video system
and the other peripherals now

are controlled from the Touch10/
DX Series user interface, you will
get a consistent user experience
throughout the meeting room.

The version of the in-room control
utility described in this document,
is available for the SX, MX and

DX Series video systems running
Collaboration Endpoint Software,
version CE9.0 or later.
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How to Use This Guide

When reading this on javascript enabled
devices the left menu bar and the entries in
the table of contents are all hyperlinks. You
can click on them to go to the topic.

Product Documentation

User guides and compliance and safety
information for Cisco TelePresence systems
are available at http://www.cisco.com/qo/

telepresence/docs

We recommend that you visit the Cisco
web site regularly for updated versions of
this guide.

Who Has Access to the Editor?

In order to access the In-room control
editor you will need to have administrator
rights.

However, an administrator may create an
In-room Control User account. With this
account it is possible to log into the codec
to run the In-room Control Editor. No other
part of the web interface is accessible from
this account.

If you use SSH to log into the codec,
only a very limited set of the API will be
accessible.
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Introduction

Definition of Terms

The following terms will be used throughout
this document:

Video system. Video system or codec in the
Cisco TelePresence MX Series or SX Series
running Collaboration Endpoint Software,
version CE9.0 or later. Sometimes referred to
as video device.

Control system. Third-party control system
with hardware drivers for peripherals, for
example Crestron, AMX, Raspberry Pi.

Touch10. Out touch-based control device for
the MX Series and SX Series video systems.
Full product name: Cisco TelePresence
Touch10. Also known as Touch10 controller, or
Touch10 user interface.

In-room control panel. Panel with controls for
third-party peripherals in the room. The panel
opens when you tap the corresponding in-

room control icon in the status bar on Touch10.

See the Create a user interface chapter for
more on this.

In-room control editor. Our easy to use drag-
and-drop editor for making in-room control
panels.

xAPI. The bidirectional API of the video system.

The xAPI allows third-party applications to
interface with and interact with the video
system, and vice versa.

Widget. User interface element, for example
buttons, sliders, and text fields, that you can
use to build an in-room control panel for
Touch10 .

VWhat Is In-Room Control?

With In-Room Control you can add
custom elements to our Touch10
user interface. Such user interface
extensions may be controls for

lights or blinds, or other peripherals
(including one or more video
switches to extend the number of
video sources available) all controlled
by external control systems.

Since both the Cisco video system
and the other peripherals now are
controlled from the Touch10 user
interface, you will get a consistent
user experience throughout the
meeting room.

The version of the in-room control

feature described in this document,
Is available for the MX, SX and

DX Series video systems running
Collaboration Endpoint Software,
version CE9.0 or later.
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INn-Room Controls

N

You can customize the Touch10/
DX user interface to allow control
of peripherals in a meeting room,
for example playback of a sound or
movie source, lights and blinds.

You can also add content sensitive
controls appearing only when in a
call and/or only outside calls.

This means that altogether you have
three sets of panels at your disposal:

8 MySystem

Lights & Blinds

—

7@ B oA

N

)

. Global panel has its entry icon =
in the status bar at the top of
the Touch10/DX display. Once
established, this entry icon is
visible at all times.

. Home panel has its entry icon
located to the right of the buttons
appearing along the bottom of the
Touch10/DX display. This entry icon
IS visible outside calls only.

. In-Call panel has its entry icon
located to the right of the buttons
appearing along the bottom of the
Touch10/DX display. This entry icon
IS visible when in a call only.

D1535805 User Guide In-Room Control for Touch10. Produced June 2017 for CE9.0. © 2015-2017 Cisco Systems, Inc. All rights reserved

In-Room Control schematics
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Touch 10
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L Video system

XAPI

Blinds

!

J

In-room
control
editor

N

A\ 4

Control system

Other...

Examples of how customization made by means of In-Room Control may appear on the Touch 10, with an icon as shown at
left and the menu appearing when that icon has been tapped, allowing control of lights and blinds, as shown at right.

N

Climate

T Y

Lights

More About How
INn-Room Control Works

To utilize the features of the In-Room
Control you will need a Cisco video
system with a Touch10/DX user
interface, and a third-party control
system, for example Crestron, AMX.

The video system’s AP, referred to
as the xAPI, is the link between the
video system and the control system.
Use the events and commands
exposed by the xAPI when you
program the control system.

The simple drag-and-drop editor
offers a library of user interface
elements, referred to as widgets.
You can use these widgets to create
your own in-room control panel for
the Touch10/DX user interface.

Together, all of this provides a

powerful combination of the control
system’s functionality and the user-
friendly Touch10/DX user interface.

All examples in this document show
Touch10 user cases only, but this
should not cause difficulties due

to the high degree og similarity
between the two interfaces..
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Creating a User Interface

Creating a User Interface for the Touch10 Shared file format

Use the in-room control editor to create customized panels for peripheral controls on the video system’s Touch10/DX user interface. The editor that you launch from the
video system’s web interface and
Connected to the Video System Offline the offline editor share the same
| | There are two places you can download the offline editor from: file format, so files created in one
If you have access to the video system, you can launch the editor from version can be opened and modified

the video system’s web interface. . Download from http://www.cisco.com/go/in-room-control-docs in the other.

If an in-room control panel already has been created on the Touch10/ . Or, sign in to a video system’s web interface with administrator

DX., this will automatically load into the editor, ready to act as a starting credentials, navigate to Integration > In-Room Control, and click
point for your design. Download Editor

When you push a new panel to the video system, you will immediately If you choose to download the offline editor, extract the files from the
see the result on the Touch10/DX. downloaded zip-file. Retain the folder structure.

When using the offline editor you will be working with files, rather than
communicating directly with the video system and Touch 10/DX. Apart
from this, the offline editor has full functionality.

L Video system

Import an
Video 1 in-room control
I N .
. _ panel from file ~ ~
Switch Import existing in-room control Push new in-room control I N -
panel from video system panel to video system — | ===~ " Offline in-
— | - =- room control
— €~ editor
R Export new )
in-room control
Trouble- _Importan -
. in-room control L panel to file
Siglelejilgle panel from file )
— | ===~ ? In-room Offline in-room control editor
A R — control
- €~ - editor
R Export new
in-room control
panel to file

In-room control editor launched from the video system’s web interface

Room
Simulator

T
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Creating a User Interface

Launch the In-Room Control Editor

Sign in to the video system’s web interface with
administrator credentials, navigate to Integration > In-
Room Control, and click Launch Editor.

In-Room configuration for MySystem * “«

el

If there is a set of in-room control panels on the video
system already, it will load automatically into the editor.
The Create icons (as in the below example) will then
read Edit wherever a panel has already been created.

Create custom user interfaces for

Offline version. If you are using the offline version of the Gisco Touch10 device

the editor, use a browser to open the index.html file
that you find in the rceditor folder.

With no panels already defined, the user interface will
look as shown at right.

Click on @ as indicated by the text Add your first
panel.

The first panel will be of the Home panel type (see
the previous pages for more on this). You can change
this—see the next page for more.

Video
Switch

Trouble-
shooting

Room
Simulator
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)

Export to video system (Ctrl-E) “ > T

Creating a User Interface

A TO U r Of th e | n — ROO m CO ntrOl E d |‘tor‘ Import from video system P Widgers {3 Properties

This controls the width

: Widget properties
Import from file (Ctrl-0) of a widget. Width sizes e D is used to refer to
- available depends on ol - a widget
s lgpeics Export 1o file (Ctrl-S) Widget type get.
= LEJndo, Red% and Tec: Mybuton |- Textis what appears
ame xpprt connguration Delete from video system on the Touch10
Create new panel from here to video system - ) +

My first page /
Edit xml (Al-Ctri-V)

Delete widget

Delete page More Launch simulator

options
! User manual
Clmll. = ;\

In-Room configuration for MySystem * “« ~

cisco

The properties panel will
New panel ) Wiigets @ Properies — display settings for any part

Page properties are o selected/highlighted with the
accessed by clicking here. | A
Gll-lll-

yellow frame. Selection can be

il / ORI A Panel, Page, Row or Widget.
Once you start Page é/ + ' ) " o
New panel ® to populate a N Tip! In addition to clicking
page of a panel, fow - the Undo and Redo icons, B N
the widget IDs in TS you may also use the « - T =
Q New panel Home use will appear f | K b d h t t
here to provide < N g amiliar keyboard shortcu Z Widgets {5} Properties ——
a simpler ] commands to copy and ——— _
@  New panel Giobal - DO v N\ paste (CTRL ¢ & CTRL V / N | The panel name will appear
D : CMp ¢ & CwvD V) oI e on the Touch10 together
@ Revumand] 5 Clicking a panel LI v — TE— = with the In-Room Control
in the list will 271 prectonalpad button for that panel
display panel €07 | Navigate and confirm Icon:
Widget ids 3 :
properties in :
the right panel, —_ ot G 2 \ |
Page enabling you The icon chosen here
e to change LI?O@ will be the one that
— widget_ name, icon an
’ . appears on the In-Room
location. W\
—— R @Y U © i © x g Control button for that
S 2 Wl 8 i | panel on the Touch10
& Vg e A 0 0 display
The Widget IDs shown «® = &
_ here belong to the active - / - N
Video panel (shown with a blue \ Sider At
Switch background). B Volume and light dimmer o
Example of a page not yet Add a new row to the Add a new page to the Drag widgets B SR @
populated—in this case page here current panel here onto the page to State-less actions o
the very first page of the populate it
Home panel with a single a Groucp bu;tor.l modes :
Trouble- unpopulated row Delete panel [~ I you want to assign the
. : P panel to a different location,
snooting I e this is done here.
_ Note that you cannot have
DO more than one panel per
location
_I_ Text
The system supports a maximum of three panels: Widgets are arranged in a four-column grid. The widgets are Display text or va u//x The Directional pad (New!) can be
. In-call (v_is_ible durihg calls only) placed into the grid according to the following rules: o o used to control e.g. Apple TV
+ Home (visible outside calls only) - A widget fills between one and four columns depending on ‘S | Navigate and confim
- Global (visible at all times) its size.
Spacer
An in-room control panel is arranged in pages. Each page . Rows are right-aligned. | agustiayour
Room consists of one or more rows, which you can populate with _ _ _ |
_ text and user interface elements known as widgets. - If you add more widgets than fit in one line, widgets wrap \
Simulator _ | to a new line within the same row. — |
The maximum number of pages per panel is 50. The spacer (New!) helps you get a
better layout ol | Il | I
CISCO
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API for Programming In-Room Controls

Connect to the Video System

The video system’s API (also known as the xAPI) allows
bidirectional communication with third-party control systems,
such as those from AMX or Crestron. There are multiple ways to
access the xAP!:

. Telnet

. SSH

. HTTP/HTTPS

. Ethernet port

. RS-232 /serial connection

Regardless of the method you choose, the structure of the xAPI is
the same. Choose the access method that suits your application
and video system the best.

Consult the API guide for your video system to get a full
description of available access methods and how to use the xAPI.

Go to:
http://www.cisco.com/go/sx-docs for SX Series, or
http://www.cisco.com/go/mx-docs for MX Series

Then, click Reference Guides > Command References to find the
API guides.

D1535805 User Guide In-Room Control for Touch10. Produced June 2017 for CE9.0. © 2015-2017 Cisco Systems, Inc. All rights reserved

Communicate over the AP|

The video system and the control system exchange messages
through the xAPI to make sure that the Touch10/DX In-Room
Control panel always reflects the actual status of the room.

The video system sends one or more events when someone
uses one of the controls on the Touch10/DX In-Room Control
panel, and the control system should send a command to the
video system when there is a change in the room settings.

XAPI
Touch 10 5

Video system

Commands

Control system

A\ 4

Events

The video system and the control system exchange messages
through the xAPI.

Examples:

- When someone taps a Lights On button on Touch10/DX, the
video system sends the associated events. The control system
should respond to these events by switching on the lights in the
room and send the corresponding command back to the video
system.

- When someone switch on the lights in the room, the control
system should send a command to the video system, so that
the video system can update the Touch10/DX In-Room Control
panel to reflect that the light is on.

See the Command reference chapter for an overview of all
relevant events, commands and statuses for in-room control.

11

Pairing Video System and Control System

You can register the control system as a peripheral connected to
the video system:

xCommand Peripherals Connect ID: “ID” Type: ControlSystem

where |ID is the unique ID for the control system, typically the
MAC address.

See the API guide for more details about this command, and its
options.

Heartbeats. The control system must send heartbeats to the
video system to let the video system know that the control
system is connected. The control system stays on the connected
devices list (refer to xStatus Peripherals ConnectedDevice) as
long as the video system receives these heartbeats from the
control system.

xCommand Peripherals HeartBeat ID: “ID” [Timeout: Timeout]

where ID is the unique ID for the control system, typically the
MAC address, and Timeout is the number of seconds between
each heartbeat. If Timeout is unspecified, it is assumed to be 60
seconds.

Note. If a connected unit ceases to send heartbeats, some
time will elapse until the video system detects the absence of
heartbeats—as long as up to a couple of minutes.

This works the other way around as well, up to a couple of
minutes may elapse until new heartbeats are detected by the
codec.
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Events for Widget Actions

The video system sends one or more of the following
events when someone uses the controls on the
Touch10/DX in-room control panel:

. Pressed—sent when a widget is first pressed

. Changed—sent when changing a widget’s value
(applies to toggle buttons and sliders only)

. Released—sent when a widget is released (also when
moving away from the widget before releasing)

. Clicked—sent when a widget is clicked (pressed
and released without moving away from the
widget).

These events are sent in two versions:

. Userinterface Extensions Event—suited for terminal
output mode

. Userlnterface Extensions Widget—suited for XML
output mode.

See the table at right to find out the version best suited
for your control system to register to.

When, and by which widgets (user interface elements),
these events are triggered, are described in the Widgets
chapter.

D1535805 User Guide In-Room Control for Touch10. Produced June 2017 for CE9.0. © 2015-2017 Cisco Systems, Inc. All rights reserved
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Userlnterface Extensions Event (suited for terminal output mode)

Userlinterface Extensions Widget (suited for XML output mode)

A single string contains information about the type of action, which widget

triggered the event (identified by the Widget ID), and the widget value.

The type of action, which widget triggered the event (identified by the
Widget ID), and the widget value are included as separate elements in
the XML tree.

How to register:

xfeedback register event/UserInterface/Extensions/Event

Example:

*e UserInterface Extensions Event Pressed Signal: "WidgetId:Value"

** end

*e UserInterface Extensions Event Changed Signal: "WidgetId:Value"

** end

*e UserInterface Extensions Event Released Signal: "WidgetId:Value"
** end

*e UserInterface Extensions Event Clicked Signal: "WidgetId:Value"

** end

How to register:

xfeedback register event/UserInterface/Extensions/Widget

Example:

<Event>
<UserInterface item="1">
<Extensions item="1">
<Widget 1tem="1">
<Action item="1">
<WidgetId item="1">WidgetId</WidgetId>
<Value item="1">Value</Value>
<Type item="1">Type</Type>
</Action>
</Widget>
</Extensions>

</UserInterface>
</Event>

Two event versions that a control system can register to: one suited for terminal output mode, the other for XML output mode

T
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Event for Panel Update

The video system sends the following event when a new In-
Room Control panel is applied:

LayoutUpdated—sent when a new in-room control panel for
Touch10/10 is exported to the video system.

As a response to this event, the control system should send
commands to initialize all widgets so that they reflect the true
status of the room settings.

How to register:
xfeedback register event/UserInterface/Extensions/Widget/

LayoutUpdated

Example:

Terminal output mode:
*e Userlnterface Extensions Widget LayoutUpdated

** end

XML output mode:
<Event>

<Userlnterface item="1">
<Extensions item="1">
<Widget item="1">
<LayoutUpdated item="1"/>
</Widget>
</Extensions>
</UserInterface>

</Event>

D1535805 User Guide In-Room Control for Touch10. Produced June 2017 for CE9.0. © 2015-2017 Cisco Systems, Inc. All rights reserved

Event for Opening or Closing of a Page

If you have given each of your pages a uniqgue Page ID, the
system can send events when a page is opened or closed.

EventPageOpened—sent when a page is opened
EventPageClosed—sent when a page is closed

The pages are like radio buttons, opening another page will close
the current page. In that case both the EventPageClosed and the
EventPageOpened will be issued.

How to register:
xfeedback register event/UserInterface/Extensions/PageOpened

xfeedback register event/UserInterface/Extensions/PageClosed

Example:
Terminal output mode:

*e UserInterface Extensions Event PageOpened Pageld:
“appletvpage”

*e UserInterface Extensions Event PageClosed Pageld:
“appletvpage”

13

XML output mode:
<kEvent>
<Userlnterface item="1">
<Extensions item="1">
<Page item="1">
<Action item="1">
<Pageld item="1">appletvpage</Pageld>
<Type item="1">Opened</Type>
</Action>
</Page>
</Extensions>
</UserInterface>

</Event>

For an example of PageClosed, just substitute Closed for Opened
in the example at left. This event will typically be used when you
want the controller to take some action based on the event, in
this case turning on (off) the AppleTV box for you.
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Commands and Statuses

The SetValue command, which sets the value of a
widget, is essential when working with in-room controls:

xCommand UserlInterface Extensions Widget SetValue
Value: Value WidgetId: WidgetId

When the video system receives a SetValue command,
the video system’s status and the Touch10/DX In-Room
Control panel are updated accordingly.

It Is important that the control system sends Setvalue
commands in the following situations, so that the
Touch10/DX In-Room Control panel truly reflects the
status of the room:

. When the control system initially connects to the video
system.

. When the video system restarts.
. When the control system restarts.

. When a new In-Room Control panel is exported to
the video system from the In-Room Control editor (as
response to the LayoutUpdated event).

. When someone physically changes something in the
room, for example turns on the lights using a wall
control.

. As a response to an event, for example when
someone has tapped the Lights On button on the
Touch10/DX In-Room Control panel.

. The control system must also do all that is necessary
in the room to reflect the action on the Touch10/DX
In-Room Control panel, for example switch on the
light.

Consult the Widgets chapter for more details about
which commands apply to the different widgets (user
interface elements).

D1535805 User Guide In-Room Control for Touch10. Produced June 2017 for CE9.0. © 2015-2017 Cisco Systems, Inc. All rights reserved

Examples

Video system Control
User with Touch 10/DX system Lights

Tap Lights On

A 4

Pressed and
Released events for
Lights On widget N

Turn lights on

A 4

Set the value of the

Lights On widget to
The appearance of active

the light widget has

changed to match

what the user can
see in the room

N

N

Message flow—turn on the lights using the controls on Touch10/DX

Video system with  Control

User Touch 10/DX system Lights User
Turn lights
on with wall
Set the value Signal that ¢ control

of the Lights lights are on
On widgetto | €

The P active

appearance of
the light widget
has changed to
match what the
user can see in
the room

A

Message flow—turn on the lights using the wall control

14

T
CISCO



Video
Switch

Trouble-
shooting

Room
Simulator

D1535805 User Guide In-Room Control for Touch10. Produced June 2017 for CE9.0. © 2015-2017 Cisco Systems, Inc. All rights reserved

Widgets

15

T
CISCO



Video
Switch

Trouble-
shooting

Room
Simulator

Widgets

Overview of Widgets

About Widgets

The Touch10/DX In-Room Control panel is composed of user
interface elements called widgets. You can find the complete
widget library in the right pane of the In-Room Control editor.

General tab: Buttons with custom text, group buttons, toggle
button, sliders, text fields and more.

Icons tab: Buttons with familiar symbols for Home, Power, Arrow
up/down/left/right, Camera controls, Loudspeaker controls,
Microphone control, Media player controls, and more.

Each of the widget type available are described on the
following pages, with emphasis on:

. Commands that change the value of the widget

. Events that are sent (pressed, changed, released, clicked) and
which actions trigger these events

. Examples of commands and events, both in terminal output
mode and XML output mode.

Syntax and semantics for all events, commands and statuses that
are related to in-room controls (user interface extensions) are
included in the Command reference chapter.

D1535805 User Guide In-Room Control for Touch10. Produced June 2017 for CE9.0. © 2015-2017 Cisco Systems, Inc. All rights reserved

The Widget Identifier

All widgets on a Touch10/DX in-room control panel need a
unique identifier, a Widget ID. The Widget ID may either be
defined by you, or assigned automatically. The Widget ID can be
any name or number; we recommend using a descriptive name
without special characters. The maximum number of characters
s 40.

The Widget ID is the programming link between Touch10/DX,
the video system, and the control system. The Widget ID will be
included in all events that are associated with a widget, and you
must use the same identifier when you send commands to that
widget via the code that you write for your control system.

16

Group ldentifiers

One of the widgets, the Group button, has two types of
identifiers: The Widget ID refers to the complete group of buttons,
while Group IDs are unique identifiers for the individual buttons
within the group.

's Widget_ID_groupbutton 3

Option 1 Option 2 Option 3
— Group_ID_one —J_ Group_ID_two —J_ Group_ID_three —

A Group ID is assigned automatically, but can be defined by you
instead. A Group ID can be any name or number; we recommend
using a descriptive name without special characters. The
maximum number of characters is 255.
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Switch

Switch

_

on off

A two-state switch which
indicates either on or off.

Events

Changed—triggered when the
button is released.

Value: <on/off>

Commands

The visual appearance of the
button changes immediately
when you tap it. However, the
control system must always

send a SetValue command to the
video system when the button
toggles between on and off. This
ensures that the status is updated
accordingly.
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About Switches

Example: Press on" on a switch with Widgetld = " togglebutton”. Switch is a two-state button which

| indicates either on or off.
................................................................... Termll’]a| mOde

*e Userlnterface Extensions Event Changed Signal: "togglebutton:on" Example of use: Anything that can
** end be turned on or off, for example
......................................................................... ML THOGE oo lights, fan, and projector.

<Event> :
You can also use it as a toggle button

together with a slider for lights to be
dimmed.

<Userlnterface item="1">
<Extensions item="1">
<Widget item="1">
<Action item="1">
<WidgetId item="1">togglebutton</WidgetId>
<Value item="1">on</Value>
<Type item="1">changed</Type>
</Action>
</Widget>
</Extensions>
</UserInterface>
</Event>

Example: Set a button with Widgetld = " togglebutton” to "on".

xCommand UserlInterface Extensions Widget SetValue WidgetlId: "togglebutton" Value: "on"

T
CISCO
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Widgets
Slider About Sliders
@ Events
Pressed Triggered when the Example: Press the slider with Widgetld = “slider’, and move it into a new A slider selects values within a
slider is pressed position (“68”), and release. set range. The minimum value is
Value: N/A | represented by O, and the maximum
@ ................................................................... e epenadiy 0 na e e
Changed Triggered when the *e UserInterface Extensions Event Pressed Signal: “slider” the slider is being pressed and
slider is moved while ** end moved, events are sent maximum 5
holding down, and *e Userlnterface Extensions Event Changed Signal: “slider:32” times a second.
Slider . .
— A when the slider is ** end
released. *e UserInterface Extensions Event Changed Signal: “slider:68” When you tap the bar, the slider is
@ Value: 0-255 ** end immediately moved to that new
*e UserlInterface Extensions Event Released Signal: “slider:68” position.
Released Triggered when the ** and
SlidEris released 0 e XML MOAE  eeeeeeereeeesssmeemssssseeesssssces o Example of use: Dimmable lights,
Value: 0-255 <Event> volume control.
<Userlnterface item="1">
<Extensions item="1">
<Widget item="1">
<Action item="1">
<WidgetId item="1">slider</WidgetId>
<Value item="1">68</Value>
<Type item="1">released</Type>
Video <I/Action>
Switch </Widget>
</Extensions>
</UserInterface>
</Event>
Trouble-
shooting
Commands
The visual appearance of the Example: Set the slider with Widgetld = “slider” to position “98”
slider changes immediately when
you tap or slide it. However, the xCommand Userlnterface Extensions Widget SetValue WidgetlId: “slider” Value: “98”
control system must always send
a SetValue command to the video
Room system to tell the new position of
Simulator the slider. This ensures that the
status is updated accordingly. T

CISCO
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Room

Simulator

Widgets

Button

Button

Slate-1ess actons

Events

Pressed Triggered when the
button is pressed.
Value: N/A

Changed Triggered when the
button is released.
Value: N/A

Released Triggered when the
button is released.
Value: N/A

Commands

Use the Setvalue command to
highlight or not the button in the
user interface. A value of “active”
will highlight the button, and a value
of “inactive” will release it.
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)

Example: Press and release the button with Widgetld = “button’

................................................................... Terminal mode B I I R I I I R R R R

*e UserInterface Extensions Event Pressed Signal: “button”

** end
*e UserInterface Extensions Event Released Signal: “button”
** end
*e UserInterface Extensions Event Clicked Signal: “button”
** end
......................................................................... ML TROE  wwovrveeesseeeseeesoseessssise
Event>

<UserInterface item="1">
<Extensions item="1">
<Widget item="1">
<Action item="1">
<WidgetId item="1">button</WidgetId>
<Value item="1"></Value>
<Type item="1">clicked</Type>
</Action>
</Widget>
</Extensions>
</UserInterface>
</Event>

Example: Highlight the button with Widgetld = “button” (set it in active state).

xCommand UserlInterface Extensions Widget SetValue WidgetlId: “button” Value: “active”

19

About Buttons

Buttons with custom text come in
different sizes. The size determines
the maximum number of characters
you can add. Text does not wrap

to a new line. You cannot use the
SetValue command to change the
text dynamically.

A button has two states: active and
inactive. You do not have to set the
button in active state when someone
taps it; the button can be used to just
send a signal without changing the
button’s visual state.

If you want to have the buttons linked
SO that only one can be selected at a
time (radio buttons), consider to use
Group buttons (next page).

Example of use: Switching things on
and off.

T
CISCO



20
Widgets

Group Button About Group Buttons

Events

Pressed Triggered when one of Example: There are four buttons in the group with Widgetld = “groupbutton’ Groups of either two, three or
the buttons is pressed. Press the button with Group ID = “two’. four buttons with custom text are
Value: The Group ID | available. The buttons within a group
Of the button (Wlthln ................................................................... Termll’]a| mode ............................................................ are ||n|<ed SO that Only One Can be

the grOLmﬂ that Was *e Userlnterface Extensions Event Pressed Signal: “groupbutton:two”

pressed.

selected at a time (also known as

end radio buttons).

*e UserlInterface Extensions Event Released Signal: “groupbutton:two”

Released Triggered when one ** end In the Properties panel you will be

>
>

Of the buttons |S ......................................................................... XML mOde ......................................................................... O'ﬂ:ered to Specrfy the Wldth Of the
released. <Event> Group buttons—see also “A Tour of
Value: The Group ID <UserInterface item="1"> the In-Room Control Editor” on page
of the button (within <Extensions item="1"> 9 for more on width adjustments.
Group button . . wan
a Switch between modes the grOUp) that was <Widget item="1">
released <Action item="1"> The size of the button determines
<WidgetId item="1">groupbutton</WidgetId> the maximum number of characters
<Value item="1">two</Value> you can add. Text does not wrap
<Type item="1">released</Type> to a new line. You cannot use the
</Action> SetValue command to change the
</Widget> text dynamically.
</Extensions>
Example of use: Room presets that
</UserInterface> . .
are mutually excluding, like room
</Event>

Video presets where you can choose
Switch between Dark, Cool, and Bright.
Remember to deselect (release)
the preset, if it is no longer valid (for
iInstance when changing the lights

Troub!e— with a wall control, or a Touch 10
Siglelelilgle slider
Commands
The visual appearance of the button changes Example: Select (highlight) the button with Group ID = “one” in the group
immediately when you tap it. However, the control with Widgetld = “groupbutton” Then, release all buttons (no buttons are
system must always send a SetValue command highlighted).
to the video system when one of the buttons are
tapped. This ensures that the status is updated xCommand UserlInterface Extensions Widget SetValue
Room accordingly WidgetId: “groupbutton” Value: “one”
Simulator xCommand UserInterface Extensions Widget UnsetValue
Use the UnSetValue command to release all buttons WidgetId: “groupbutton” e
In the group so that no button is highlighted. CISCO
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Widgets

lcon Button

lcon button

Adjust volume, play

Video
Switch

Trouble-
shooting

Room

Simulator

Events

Pressed Triggered when the
button is pressed.
Value: N/A

Released Triggered when the
button is released.
Value: N/A

Clicked  Triggered when the
button is released
Value: N/A

Commands

Use the SetValue command to
highlight or not the button in the
user interface. A value of “active”
will highlight the button, and a value
of “inactive” will release it.
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Example: Press and release the button with Widgetld = “symbol’.

................................................................... TEIMINAl MOCE e
*e UserInterface Extensions Event Pressed Signal: “symbol”
** end
*e UserInterface Extensions Event Released Signal: “symbol”
** end
*e UserInterface Extensions Event Clicked Signal: “symbol”

** end
......................................................................... XI\/H_ mOde

<Event>
<UserInterface item="1">
<Extensions item="1">
<Widget item="1">
<Action item="1">
<WidgetId item="1">symbol</WidgetId>
<Value item="1"></Value>
<Type item="1">clicked</Type>
</Action>
</Widget>
</Extensions>
</UserInterface>
</Event>

Example: Highlight the button with Widgetld = “symbol” (set it in active
state)

xCommand UserInterface Extensions Widget SetValue WidgetId: “symbol”
Value: “active”

21

About Icon Buttons

lcon buttons share behavior behavior
with buttons having custom text.

A button has two states: active and
inactive. You do not have to set the
button in active state when someone
taps it; the button can be used to just
send a signal without changing its
visual state.

Example of use: Controls for a
media player, or other devices that
can start, stop, pause.

T
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Widgets
Spmner About Spinners
@ Events
Pressed Triggered when Example: Press and release the decrement button of the spinner with A spinner is used to step through a
one of the spinner Widgetld = “spinner”. list of values. You may use the two
buttons is pressed. | buttons to increment or decrement
@ s peses B
decrements *e UserlInterface Extensions Event Pressed Signal: “spinner:decrement” options.
** end
Released Triggered when *e UserInterface Extensions Event Released Signal: “spinner:decrement” Use the SetValue command to add
one of the spinner ** end text between the buttons.
@ buttons Is released. *e UserInterface Extensions Event Clicked Signal: “spinner:decrement”
Value: <increment/ x* and Example of use: Set the desired
QOCIBMENts e XML PROGE  woorerereeeeeeeessssssssesseeeeiesiccicicciiieeceseeeeeeeee temperature in the room.
<Event>
Clicked  Triggered when <UserInterface item="1">
one of the spinner <Extensions item="1">
buttons is released. <Widget item="1">
Value: <increment/ <Action item="1">
— decrement> <WidgetId item="1">spinner</WidgetId>
W | reRsssppoaens <Value item="1">decrement</Value>
<Type item="1">clicked</Type>
</Action>
</Widget>
Video </Extensions>
Switch </UserInterface>
</Event>
Trouble-
shooting
Commands
Use the SetValue command to add Example: For the spinner with Widgetld = “spinner’, add the text “22”
or update the text between the two between the spinner’s increment and decrement buttons.
buttons.
xCommand UserInterface Extensions Widget SetValue WidgetId: “spinner”
Value: “22”
Room
Simulator
T
CISCO
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Widgets
Text
@ Events
None
T -[rem = AN Le
Video
Switch
Trouble-
shooting
Commands

Use the SetValue command to set
the text in the text box.

Room
Simulator
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Example: Set the following text in the text box with Widgetld = “textbox”:
“The projector is warming up.’.

xCommand UserInterface Extensions Widget SetValue WidgetId: “textbox”
Value: “The projector is warming up.”

23

About Texts

Text boxes come in different sizes.
They have up to two lines of text and
the text automatically wraps to the
new line.

A small text box with larger font size
and no line wrap is also available.

You can define the initial text for the
text box in the editor, and later on
use the SetValue command to enter
text dynamically.

Example of use: Help text,
instructions, explanation of

what different presets mean, or
informative text from the control
system, such as “The projector is
warming up”.

The text box with larger font size is
primarily meant for status values,
such as the current temperature in
the room.

T
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Widgets

Directional Pad

Events

Pressed Triggered when the
button is pressed.
Value: N/A

Changed Triggered when the
button is released.
Value: N/A

Released Triggered when the
button is released.
Value: N/A

-~ Directional pad

Video B T S
. o Navigate and confirm
Switch

Trouble-
shooting

Room
Simulator
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Example: Press and release the button with Widgetld = “dirpad’.

................................................................... TOrMINGl MNOAE e
*e Userlnterface Extensions Event Pressed Signal: “dirpad:up”
** end
*e Userlnterface Extensions Event Released Signal: “dirpad:up”
** end
*e UserlInterface Extensions Event Clicked Signal: “dirpad:up”

** end

Event>
<UserInterface item="1">
<Extensions item="1">
<Widget item="1">
<Action item="1">
<WidgetId item="1">dirpad:up</WidgetId>
<Value item="1"></Value>
<Type item="1">clicked</Type>
</Action>
</Widget>
</Extensions>
</UserInterface>
</Event>

24

About Directional Pads

The Directional Pad can be regarded
as a set of b buttons, the four
Directional buttons and the Center
button.

As can be seen from the examples
at left, the event will be of the form:

“<WidgetId>:<the button pushed>”

iIn which the button pushed
assumes the value:

up, down, left, right Or center

Example of use: Controlling AppleTV

T
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Widgets

Spacer

Video
Switch

Spacer

Adjust layout

Trouble-
shooting

Room
Simulator
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The Spacer is no more than a layout tool. Consequently, there are no
events or commands associated with it.

25

About Spacers

The Spacer lets you add space
between or after widgets. It is no
more than a layout tool.

The width of the spacer is adjustable
(1-4). If you set it to maximum it will
occupy its own line, making it usable
as a vertical spacer, as well.

T
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Command Reference
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Command Reference

Events

Userinterface Extensions Event Pressed
Sent by the video system when a widget is first pressed.

Equivalent to the Userlnterface Extensions Widget Action event
with Type “Pressed”

*e UserInterface Extensions Event Pressed Signal: Signal

INn which

Signal: String (O, 255)

The format of the string is “<Widgetld>:<Value>", where
<Widgetld> is the unique identifier of the widget that triggers
the event, and <Value> is the value of the widget. The range of
allowed values depends on the widget type.

Userlnterface Extensions Event Changed

Sent by the video system when changing a widget’s value
(applies only to toggle buttons and sliders).

Equivalent to the Userlnterface Extensions Widget Action event
with Type “Changed”

*e UserInterface Extensions Event Changed Signal: Signal

In which

Signal: String (O, 255)

The format of the string is “<Widgetld>:<Value>", where
<Widgetld> is the unigue identifier of the widget that triggers
the event, and <Value> is the value of the widget. The range of
allowed values depends on the widget type.
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Userlnterface Extensions Event Released

Sent by the video system when a widget is released (even if
moving the finger out of the widget before releasing it).

Equivalent to the Userlnterface Extensions Widget Action event
with Type “Released’.

*e UserInterface Extensions Event Released Signal: Signal
in which

Signal: String (0, 255)

The format of the string is “<Widgetld>:<Value>", where
<Widgetld> is the unique identifier of the widget that triggers
the event, and <Value> is the value of the widget. The range of
allowed values depends on the widget type.

Userlinterface Extensions Event Clicked

Sent by the video system when a widget is clicked (pressed and
released without moving the finger out of the widget).

Equivalent to the Userlnterface Extensions Widget Action event
with Type “Clicked”

*e UserInterface Extensions Event Clicked Signal: Signal
in which

Signal: String (0, 255)

The format of the string is “<Widgetld>:<Value>", where
<Widgetld> is the unigue identifier of the widget that triggers
the event, and <Value> is the value of the widget. The range of
allowed values depends on the widget type.

27
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Command Reference

Events

Userinterface Extensions Widget Action

Sent by the video system when someone uses one of the
controls on the user interface (in-room control panel).

Equivalent to the Userinterface Extensions Event Type event.

Depending on the action type, this event is equivalent to one of
these events:

. Userlinterface Extensions Event Pressed

. UserlInterface Extensions Event Changed

. Userinterface Extensions Event Released

. Userinterface Extensions Event Clicked Events

<Event>
<UserInterface item="1">
<Extensions item="1">
<Widget item="1">
<Action item="1">
<WidgetId item="1">WidgetId</WidgetId>
<Value item="1">Value</Value>
<Type item="1">Type</Type>
</Action>
</Widget>
</Extensions>
</UserInterface>
</Event>

iIn which:
WidgetId: String (0, 40)
The unigue identifier for the widget that triggered the event.

Value: String (0, 255)

The value of the widget. The range of allowed values depends on
the widget type.

Type: <Pressed/Changed/Released/Clicked>
Pressed: Sent when a widget is first pressed.

Changed: Sent when changing a widget’s value (only for toggle
buttons and sliders).

Released: Sent when a widget is released (even if moving the
finger out of the widget before releasing it).

Clicked: Sent when a widget is clicked (pressed and released
without moving the finger out of the widget).

28

Userinterface Extensions Widget LayoutUpdated

Sent by the video system when the configuration file for the user
interface extensions has been updated, i.e. when exporting a
new configuration from the in-room control editor to the video
system.

*e UserInterface Extensions Widget LayoutUpdated

or

<Event>
<UserInterface item="1">
<Extensions item="1">
<Widget item="1">
<LayoutUpdated item="1"/>
</Widget>
</Extensions>
</UserInterface>

</Event>
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Command Reference

Commands

Userinterface Extensions Widget SetValue

This command sets the value of the given widget, and the
Userlnterface Extensions statuses are updated accordingly. If the
value is out of range, the command returns an error.

USAGE:

xCommand UserInterface Extensions Widget SetValue Value: Value
WidgetId: WidgetId

INn which

Value: String (0, 255)

The value of the widget. The range of values depends on the
widget type.

WidgetId: String (0, 40)
The unique identifier for the widget.
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Userinterface Extensions Widget UnsetValue

This command empties the value of the given widget, and the
Userlnterface Extensions statuses are updated accordingly. The
user interface is notified that the widget is no longer selected.

USAGE:

xCommand UserInterface Extensions Widget UnsetValue WidgetId:

WidgetId
in which
WidgetId: String (0, 40)
The unigue identifier for the widget.
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Userlnterface Extensions Clear

This command deletes all user interface extensions (widgets)
from the video system.

USAGE:

xCommand UserInterface Extensions Clear

Userlnterface Extensions List

Use this command to list all user interface extensions (widgets)
that exist on the video system.

USAGE:

xCommand UserInterface Extensions List

T
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Statuses

Userlnterface Extensions Widget [n] Widgetld

Userlinterface Extensions Widget [n] Value

This status returns the identifier (Widgetld) and the current value
of the widgets.

The value is an empty string until a value is set by using the
Userlinterface Extensions Widget SetValue command.

USAGE:

xStatus UserlInterface Extensions
Value space of the result returned:

Value: The value of the widget. Depends on widget type. String
(0, 255).

Widgetld: The unique widget identifier. String (0, 40).
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Example:

xstatus UserInterface Extensions

*

n

UserInterface Extensions Widget

UserInterface
UserInterface
UserlInterface
UserInterface
UserInterface
UserInterface
UserInterface
UserInterface
UserInterface

UserInterface
ready”

UserInterface

end

Extensions
Extensions
Extensions
Extensions
Extensions
Extensions
Extensions
Extensions
Extensions

Extensions

Extensions

Widget
Widget
Widget
Widget
Widget
Widget
Widget
Widget
Widget

Widget

Widget

A\ 144

Value: “on

WidgetId: “togglebutton”

Value: “255”
WidgetId: “slider”
Value: “Blinds”
WidgetId: “spinner”
Value: “i1nactive”
WidgetId: “button”
Value: “2”

WidgetId: “groupbutton

Value: “Projector is

WidgetId: “textfield”
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Using a 3rd Party Video Switch to Extend the Number of Video Sources Available

The Cisco Touch10 panel can now be configured to show video
sources from a 3rd party external video switch in the normal
Share Tray view.

The sources will appear, and behave, as any other video source
connected directly to the codec. For the user this will be
perceived as completely transparent— no video switch seems to
be involved.

8% Anton Arbring I &k 16:11

Apple TV Blu-ray

v
Stop sharing

The video switch feature requires, similar to in-room controls, a
third party control system. The control system will use the Codec
API to syncronize the source states between the video switch
and the Touch10 user interface using a set of API events and
commands.

In order to make this work when the user selects a video
source from the Touch10, the codec must be set to issue a
corresponding event, which in turn shall cause the controller to
send appropriate commands to the video switch and the codec.

This event will be issued only if the controller has registered to
the codec upon connection, requesting the following from the
codec:

xFeedback register Event/UserInterface/Presentation/
ExternalSource

The event issued will be as follows:

*e UserInterface Presentation ExternalSource Selected
Sourceldentifier: “XXXX”
Where “XXXX” is a unique string ID used to identify this source
when selecting or setting state —see the following pages for more
on this.
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Furthermore, there are six commands available to
control the system:

Add: Adds video source identifiers, including ID of
connector, the name to appear on the Touch10, a

unique string ID to identify a source when selecting
or setting state, and what type of icon to display on
Touch10 for each source.

List: Returns the current list of external sources.
Remove: Removes a source from the list.
RemoveAll: Removes all of the sources from the list.
Select: Selects a specific source.

State Set: Changes the state of a source.

These are all presented in detail on the following
pages.

A simple example of a setup using the configuration
shown above is provided in the article “Video Switch

Cisco Codec
D e D 1 D 1 D 0 D 1 D 1 D ) 1 com 5
N III - o> o= Emm: (l' (IDWIIII"IIII o S
\SE-CX4 D om 2 m @m/ﬂ (0] (G =] @ -
LAN connection,
Serial connection
etc.

e

N Third-party
- Controller
@

Example” on page 34.

LAN connection,
Serial connection
etc.

: -
HDMI Out HDMI Input

1

- Third-party Video Switch (simplified for clarity)

Video input sources
(PC, Cameras, DVD, Document Camera, Apple TV, Chromecast etc)
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Command Detalls

Userlinterface Presentation ExternalSource Add

This command establishes and defines an input source.

xcommand UserInterface Presentation ExternalSource Add
ConnectorId: Connectorld Name: Name Sourceldentifier:
Sourceldentifier Type: Type

in which:
ConnectorId: The ID of the codec connector to which the
external switch is connected

Name: Name displayed on touch 10

Sourceldentifier: A unique string ID used to identify this source
when selecting or setting state

Type:. Decides what icon is displayed on the Touch 10, choose
between: <pc/camera/desktop/document_camera/mediaplayer/
other/whiteboard>

Example:

xcommand UserInterface Presentation ExternalSource Add
Connectorld: 3 Name: “Blu-ray”
Sourceldentifier: bluray Type: mediaplayer

Userlinterface Presentation ExternalSource List

This command returns the current list of external sources.

xcommand UserInterface Presentation ExternalSource List

Userinterface Presentation ExternalSource
Remove

This command removes a source from the list.

xcommand UserInterface Presentation ExternalSource Remove
Sourceldentifier: Sourceldentifier

in which:
Sourceldentifier IS a unique string ID used to identify this
source when selecting or setting state.
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Userlnterface Presentation ExternalSource
RemoveAll

This command removes all sources from the list.

xcommand UserInterface Presentation ExternalSource RemoveAl

Userlnterface Presentation ExternalSource
Select

Starts to present the selected source if it is in ready state and
has a valid Connectorld. Also shows the item in sharetray as
“Presenting’.

xcommand UserInterface Presentation ExternalSource Select
Sourceldentifier: Sourceldentifier

in which:

SourceIdentifier is a unigue string ID used to identify this source
when selecting or setting state.

33

Userlnterface Presentation ExternalSource State
Set

Used to change state of the source with Sourceldentifier.

xcommand UserInterface Presentation ExternalSource State
Set Sourceldentifier: Sourceldentifier State: State
[ErrorReason: LrrorReason]

in which:
Sourceldentifier: is a unique string ID used to identify this

source when selecting or setting state

State: <Error/Hidden/NotReady/Ready> Ready is the only
presentable state, hidden exists in the list but does not show In
the sharetray.

ErrorReason: Optional. Displays in the share tray if the state is set
to Error.
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Video Switch Example

A simple example of setup could be: P

Controller sending:

xcommand UserInterface Presentation ExternalSource Add
ConnectorId: 3 Name: “Blu-ray” Sourceldentifier: bluray
Type: mediaplayer

xcommand UserInterface Presentation ExternalSource Add
ConnectorId: 3 Name: “Apple TV” Sourceldentifier: appletv
Type: mediaplayer

xcommand UserInterface Presentation ExternalSource Add

16:11

ConnectorlId: 3 Name: “TV” Sourceldentifier: tv Type:
mediaplayer

The default state is NotReady (Fig. 1)

S0 the next step for an integrator would be to set them to ready 4 Hron e
(Fig. 2).

xcommand UserInterface Presentation ExternalSource State Set
State: Ready Sourceldentifier: bluray

xcommand UserInterface Presentation ExternalSource State Set
State: Ready Sourceldentifier: appletv

16:11

16:11

xcommand UserInterface Presentation ExternalSource State Set
State: Ready Sourceldentifier: tv
If one of the sources is selected on the video switch the controller
should send a command accordingly:
xcommand UserInterface Presentation ExternalSource Select
Sourceldentifier: tv &
If the switch is connected on the chosen connector it will start to
present (Fig. 3).
When a user selects another source, by clicking the other source
item in the share tray, the codec will send the following event: Apple TV
*e UserInterface Presentation ExternalSource Selected
Sourceldentifier: “appletv”
The Controller should listen to this event and display the selected

source.
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Fig. 1 Default state is NotReadly.

Fig. 2 When Input sources have
been set to Ready.

Fig. 3 If the switch is connected on
the chosen connector it will start to
present.
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Troubleshooting

Using the Development Tools on the Web Interface for Troubleshooting

Sign In Check for Events and Status Updates

In-Room Control

Sign in to the video system’s web interface with administrator All events and status updates related to widgets appear You can customize our user interface to allow control of peripherals in a meeting foom, for example lights and biinds.
credentials, navigate to Integration > In-Room Control. Click the immediately in the Log window. Events are prefixed with *e, e sl B peneru oo e e e Rty e e o e
arrow to show the Development Tools. and statuses are prefixed with *s. Create/Edit Interfaces
i Launch the editor to create custom user interface panels.

Events appear when you use the controls on the Touch 10 ceodplalbedhlee | ¢
Overview of all Wid gets an d Their Status usgr interface, and the status is ujpdated vvhen a command, BRI 0o e ok s ol gt e i

which changes the video system’s status, is sent to the
The Widget State Overview window lists all widgets, and their video system. Launch Simulator | Launch a room simulator in your browser.
status. The status is shown in the Current Value column.
If the Current Value column is empty, the widget has not been | Jevelopment ook @
initialized and has no value. We recommend that the control system It a Panel Fails to Load Log Filotleashpmiinetal . Gleagioss
initializes all widgets when it initially connects to the video system. If an existing in-room control panel failed to load i i o RS R S

automatically on launching the editor, you may manually e e

import the panel(s) from codec or load a local file made s asdblenns el L

Monitor started.

Send Value Updates to the Video System with the offline editor. s e 1 0 S s e

A control system sends SetValue commands to the video system,
telling it to update a widget. For test purposes, you can use the
Update Value column in the Widget State Overview window to

All alternatives erase any unsaved data in the editor, but
the existing in-room control panel on the video system is
neither overwritten nor deleted until a new panel is exported

SimU|ate d COI’T[I’O| SyStem- to the VideO SyStem. View the touch Ul events (*e) and widget status changes (*s) that occur when the user interface is operated.
Video
Switch Enter a value in one of the input fields to immediately send the Widget State Overview
corresponding SetValue command to the video system. The D Type Current Value Update Value
CurrentValue column (status) will be updated, and the Touch10 in- widget_3 Text Unset
room control panel changes accordingly. reset_room Button " ) kdiscle
Troub|e— hvac_power Button inactive inactive v|| Unset
Siglele]ilgle Click Unset to clear the value of the widget (send an UnsetValue temperature_setpoint  Spinner 210 210 Unset
comman d) . temperature Text 16.0 16.0 Unset
weather Text Partly cloudy. Temperature: 12.0 (C! Partly cloudy. Temperature: 12.0 (C! || Unset
If @ control system is connected to the video system, the Current blinds Spinner Unset
Value and Update Value columns may come out-of-sync. The e ot Unset
Current Value column always shows the current status, regardless lights_slider Sider 0 0 Unset
of whether the SetValue command is sent from a real control ights_togale ToggleButton | of of v unset
system, or from the Update Value column. el P ToggleButton  [OF off v unset
projector_canvas Spinner Unset
Room blinds_preset GroupButton 0 0: Open v | Unset |

Simulator

The ‘Current Value’ column shows the current status values of the widgets. The ‘Update Value’ column allows you to set the current widget values. This allows you
to simulate the behaviour of a control system so changes will be reflected on your touch panel. If there is a control system connected to the codec, it may set
values causing the ‘Current Value' column to be out-of-sync with the “Update Value’ inputs.

D1535805 User Guide In-Room Control for Touch10. Produced June 2017 for CE9.0. © 2015-2017 Cisco Systems, Inc. All rights reserved



Video
Switch

Trouble-
shooting

Room
Simulator

D1535805 User Guide In-Room Control for Touch10. Produced June 2017 for CE9.0. © 2015-2017 Cisco Systems, Inc. All rights reserved

1ps and Iricks

37

T
CISCO



Video
Switch

Trouble-
shooting

Room
Simulator

Tips and Tricks

Recommended Best Practice

Re-register to Get Feedback After Restart

When either the video system or the control system restarts, the
control system must re-register to the events that the video system
sends when someone uses the Touch10/DX in-room controls or
pushes a new in-room control panel to the Touch10/DX.

For terminal output mode:

xfeedback register event/UserInterface/Extensions/Widget

For XML output mode:
xfeedback register event/UserInterface/Extensions/Event

xfeedback register event/UserInterface/Extensions/Widget/
LayoutUpdated

Consult the API for in-room control chapter for more details.

Initialize All Widgets

Make sure the control system initializes all the widgets on the
Touch10/DX in-room control panel in the following situations:

. When the control system connects to the video system for the
first time

. When the video system restarts

. When the control system restarts

. When a new in-room control panel is exported to the video
system (as response to a LayoutUpdated event).

If this is not done, then the Touch10/DX may show incorrect
values and not truly reflect the status of the room.

Use the SetValue command to set the initial values.

Always send values back to the video system when something
changes.

To avoid unexpected behavior and ambiguities, the control system
must always send SetValue commands to the video system when

something changes. This applies also when the change is triggered
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by someone using the controls on the Touch10.

For example, it makes no difference if you use a slider on the
Touch10/DX in-control panel to dim the light, or a physical
dimmer in the room, or another touch panel. The control system
must always send the dimmer value back to the video system
using the SetValue command.

Update the In-room Control Panel

When you export a new in-room control panel to the video
system, the old panel is overwritten and replaced by the new one.

To update, do as follows:

1.Launch the in-room control editor from the video system’s web
interface.

2.Create the in-room control panel you want, or import a
previously saved panel from file (Import > From file).

3. Click Export > To codec.

Other Useful Stuff

Remember previous values when turning lights off (e.g. a light
with a slider for dimming and toggle for on/off), remember the
current light state when turning off, and use that value when
turning back on.

Example: If the light is at 40%, and the user presses off, she will
expect it to go back to 40% (not 100%) when pressing pressing
the “on” again. Remember also to set the power switch to off if
sliding to 0%.

For blinds, consider using the following strategy: Short press on
a direction arrow tilts the blinds. If tilted all the way already, moves
the blinds slightly.

Long press on a direction arrow starts moving the blind that
direction, doesn’t stop until blinds are all the way up/down.
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To stop movement after long pressing, short press any button
(stop button is not really necessary)

Remove Entire In-room Control Panel and lcon

If there is an in-room control panel on the video system then
there is also a corresponding in-room control icon, either in the
Touch 10/DX status bar or as a button to the right of the call
control buttons. Even if a panel is empty and contains no widgets,
both the icon and the panel will be visible.

Do as follows to remove an in-room control panel and icon
from Touch10/DX:

1.Launch the in-room control editor from the video system’s web
interface.

2.Select the panel to be removed (Global, Homescreen or In-
call)

3. Click Delete panel.

Transitioning from 3rd Party Control Systems to CE

If you already have been using a third party control system
and want to start using CE as described in this document, we
recommend the following:

. Let any programming made to control third party stuff remain
untouched.

- Remove all code that controls the Cisco video endpoint as that
Is now already controlled via the Touch10/DX.

. Reprogram the signalling from the button-presses coming from
the third party control system panel so that it listens to button
presses from the Touch10/DX instead.

This programming can be very simple to do as the largest control
system manufacturers provide modules/drivers for in-room
Controls making it very easy to get started with the programming.

T
CISCO



Video
Switch

Trouble-
shooting

Room

Simulator

Tips and Tricks

Recommended Best Practice (cont.)

Inspirational Examples

The following examples may serve as inspiration and to provide
further guidance on best practices. It is by no means mandatory

to design and implement controls as illustrated in these examples.

Wigdget ID

When you drag a widget (e.g. a button) onto a page, you may
give it a customized ID.

Widget IDs do not have to be unique. Widgets can share ID, but
they must be of the same type.

This means that you can have two sliders in different panels
called “main-light’} but not one slider and one toggle button both
called “main-light’

To create a duplicate of an existing widget on another page or
panel, just use Copy and Paste.

Create Groups of What Belongs Together

Consider grouping controls that belong together on the same
page. The pages you create in the in-room control editor appear
as separate tabs on the control panel.

Control of Lights

The combination of a slider and a toggle button could be used to
control lights. The toggle button switches the lights on or off; the
slider serves as a dimmer.

Consider the following strategy:

- Set the slider to minimum when the user turns the lights off

- Set the toggle button to off when the user moves the slider to
ItS minimum
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- Remember the value of the slider when the lights are turned
off, so that you can return to this value when the lights are
turned back on again

- If the light is at 40 %, when the user switches it off, he or she
would expect it to go back to 40 % (not maximum) when
switching the lights on again

- When the user selects one of the options in the group button (a

light preset), set the sliders and toggle buttons accordingly

- If the lights are changed away from a preset, for instance by
changing a slider or toggle button, deselect all options in the
group button.

Control of Temperature

The combination of a spinner and a large font text box (value)
may be used to control temperature. Use the spinner to set the
desired temperature, and the large font text box to show the
current temperature.

For the best user experience remember the following:

- Update the large font text box as the temperature in the room
changes.Update the text field of the spinner when someone
tap the up and down arrows

- Consult the Widgets chapter for details about how to update
the spinner’s text field and the large font text box.

Control of Blinds

You can either use a spinner, or up and down arrows from the
lcons tab in the widget library.

Consider the following strategy:

- Tilt the slides as response to a short press on a direction arrow.

If tilted all the way, move the blinds up or down incrementally

39

- As response to a long press on a direction arrow, start moving
the blinds in that direction. They do not stop until all the way up
or down

- Short press any button in order to stop the movement after a
long press. Then no separate stop button will be needed.

Use a Button Only to Send a Signal

A button can be used just to send a signal, without changing the
button’s state or visual appearance.

As an example, use the All lights on button to switch on all lights.
Do not change the button’s color from gray to blue, but update
the other light controls to reflect the true status of the room.

Group Buttons

Group buttons are ideal when you want buttons to be linked,
SO that only one can be selected at a time. For example room
presets.

When the individual buttons in a group are too small to contain
the text that describes their function, consider to use text boxes
for the description.

T
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\Who Has Access?

Granting Access to In-Room Control Editor and Extensions AP|

In order to access the In-room control editor you will need to
have administrator rights.

However, an administrator may create an In-room Control User
account. With this account it is possible to log into the codec to
run the In-room Control Editor. No other part of the web interface
Is accessible from this account.

If you use SSH to log into the codec, only a very limited set of the
APl will be accessible.
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Trouble-
shooting

Room
Simulator
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Running the Simulator

In order to make it possible to demonstrate the features of the In-
Room Control, we have made a simulator for you. The simulator
should primarily be regarded as a sales tool.

No external controller is needed when running the simulator.

The simulator uses a predefined In-room Control setup. This
cannot be changed. The predefined setup will overwrite the
setup in the codec. Your current setup will be backed up in your
browser and reinstalled after the session (you will be prompted to
confirm that).

Note! As the simulator is self-contained, any controller connected
to the codec should be disconnected when running the simulator
to avoid conflicts.

Tip! We recommend using Google Chrome browser when
running the simulator. Other browsers may fail to run the simulator

properly.

To invoke the simulator navigate to Integration > In-Room
Control in the web interface and then select Launch Simulator:

-lllrllh K. My System
cisco Cisco TelePresence SX80
#A Home ‘ . Call Control ‘ 4 Setup ‘ & Security ‘ £ Maintenance ‘ - Integration ‘ & doc

In-Room Control

You can customize our user interface to allow control of peripherals in a meeting room, for example lights and blinds

This allows for the powerful combination of an external control system’s functionality and the Cisco user interface.

Create/Edit Interfaces

Launch Editor Launch the editor to create custom user interface panels.
Export them to the video system to make them appear in the user interface, or
save the designs in local files for later.

Download Editor Download the editor to create interface designs offline, for export to the video
system later.

< Launch Simulator > Launch a room simulator in your browser.

T—
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The Example Room will now appear. Click on Load Simulator
Config. Once succesfully loaded click anywhere to remove
messages when needed.

CIsCO

Simulator

Try out how the whole
meeting experience can
be managed using In-
room controls.

{:I» Load simulator config

-I:I- Clean up

Click on the Touch (1) to enlargen it and then click as shown (2)
to invoke the In-Room Controls:
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You may now play with the controls on the virtual Touch, but also
with the switches themselves in the room. Click Clean up to finish
and restore previous settings.

Simulator

Try out how the whole

meeting experience can
be managed using In-
m controls

4} Load simulator config
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On our web site you will find an overview of the worldwide Cisco contacts.

Go to: http://www.cisco.com/go/offices
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